Cummins 6.7L CM2100A CSP⁵
User Guide

Cindy Myers
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisites</td>
<td>4</td>
</tr>
<tr>
<td>Intended Audience</td>
<td>4</td>
</tr>
<tr>
<td>Computer Knowledge</td>
<td>4</td>
</tr>
<tr>
<td>Tuning Knowledge</td>
<td>4</td>
</tr>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>What is EFILive?</td>
<td>5</td>
</tr>
<tr>
<td>What is EFILive CSP&lt;sup&gt;5&lt;/sup&gt;?</td>
<td>5</td>
</tr>
<tr>
<td>Software Version Overview</td>
<td>6</td>
</tr>
<tr>
<td>CSP&lt;sup&gt;5&lt;/sup&gt; Upgrade</td>
<td>7</td>
</tr>
<tr>
<td>CSP&lt;sup&gt;5&lt;/sup&gt; Upgrade Checklist</td>
<td>7</td>
</tr>
<tr>
<td>Upgrade Operating System to CSP&lt;sup&gt;5&lt;/sup&gt;</td>
<td>7</td>
</tr>
<tr>
<td>Tune Switch Password</td>
<td>9</td>
</tr>
<tr>
<td>CSP&lt;sup&gt;5&lt;/sup&gt; Output Driver</td>
<td>9</td>
</tr>
<tr>
<td>CSP&lt;sup&gt;5&lt;/sup&gt; Tune 6 - Switch via ECM Input</td>
<td>10</td>
</tr>
<tr>
<td>CSP&lt;sup&gt;5&lt;/sup&gt; CAN Tunes</td>
<td>10</td>
</tr>
<tr>
<td>Supported Switching Methods</td>
<td>11</td>
</tr>
</tbody>
</table>

---

support@efilive.com

www.efilive.com
Flash Base with without tune file security restrictions........................................23
ROM Boot Recovery..........................................................................................23
Test for Rogue Modules....................................................................................23
Trace Files .......................................................................................................23
  V8 Scan and Tune *.htx files ........................................................................23
  FlashScan/AutoCal V3 *.xalm files ..............................................................24
  FlashScan V2 Trace Files ............................................................................24
Knowledgebase.................................................................................................24
EFILive Authorized Dealer ..............................................................................25
How to Tune? ....................................................................................................25
EFILive Service Desk .......................................................................................25
Prerequisites

Intended Audience
EFILive Customers using the V8 Scan and Tune Tool software.

Computer Knowledge
It is expected that readers have a basic understanding of:

- The Windows operating system;
- Starting and using Windows applications;
- Navigating folders using Windows Explorer.

Tuning Knowledge
It is expected that readers have a basic understanding of:

- Electronic Fuel Injection;
- On Board Diagnostics.
Introduction

What is EFILive?
EFILive is tuning software and hardware - it is not a tune. Together the software and hardware give users the tools to write tunes. EFILive does not provide tune files, tuning advice or support, but do provide software support and hardware support.

What is EFILive CSP\(^5\)?
EFILive's CSP\(^5\) custom operating systems for Cummins controllers allows customers to be able to switch 'on the fly' between multiple tunes, all stored in the ECM's flash memory. Historically, Cummins Switchable Programming had 5 tune positions; however as supported Cummins platforms have expanded this no longer holds true. ECM memory now defines the number of tunes that are available for switching for each ECM type as per the table below.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CMB (CM849)</td>
<td>CSP(^5)</td>
<td>5 tunes accessible through CAN bus switching, and a 6(^{th}) tune that is switched using an input on one of the ECM connectors.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMC (CM2100A)</td>
<td>CSP(^5)</td>
<td>5 Tunes accessible through CAN bus switching.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMD (CM2200)</td>
<td>CSP(^2)</td>
<td>2 tunes accessible through CAN bus switching.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pick Up Trucks</td>
<td>CSP(^4)</td>
<td>4 tunes accessible through CAN bus switching.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMD (CM2200)</td>
<td>CSP(^5)</td>
<td>5 tunes accessible through CAN bus switching.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cab &amp; Chassis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CME (CM2350B)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMF (CM2450B)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CSP\(^5\) delivers scanning enhancements to customers via Enhanced Data Acquisition (EDA). EDA, EFILive’s custom scanning mode is the first of its kind and aims to simplify the task of information sharing between users as every individual data parameter has been selected with tuning feedback in mind. EDA allows customers to log 45 individual data parameters specifically chosen to...
complement tuning at up to 50 frames per second for V8 BBL & V7.5 pass through logging.

EDA scanning is only available on CSP5 upgraded ECM’s.

**Software Version Overview**

This version of the Cummins 6.7L CM2100A CSP5 User Guide migrates all processes to EFILive V8 Scan and Tune software. Functionality is still available in V7.5 software, however software support and bug fixes will cease in 2021.

FlashScan/AutoCal V3 and AutoCal V2 are not compatible with V7 software. V7 functions are only supported by FlashScan V2. The following is a brief view of the activities that are performed with the different software versions:

<table>
<thead>
<tr>
<th>Feature</th>
<th>V7</th>
<th>V8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanning</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>OBDII Diagnostics</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Reading</td>
<td>❌</td>
<td>✔️</td>
</tr>
<tr>
<td>Flashing</td>
<td>❌</td>
<td>✔️</td>
</tr>
<tr>
<td>Tune Editing</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>VIN License Management</td>
<td>❌</td>
<td>✔️</td>
</tr>
<tr>
<td>Firmware Management</td>
<td>❌</td>
<td>✔️</td>
</tr>
</tbody>
</table>
CSP5 Upgrade

CSP5 Upgrade Checklist

CSP5 upgrades are only available on specific factory operating systems. Typically these are based on the latest factory update (at time of development). If you have a truck that has an OS not listed below, you will need to upgrade your base file first.

Supported CSP5 operating systems are listed in the table below. These were the latest factory updates as of early 2015; released 5 years after this ECM type was introduced.

EFILive will not be offering CSP on older, obscure or obsolete OS’s. No further EFILive development is scheduled for the Dodge Cummins CMC platform.

<table>
<thead>
<tr>
<th>CSP5 Supported Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>11520902</td>
</tr>
<tr>
<td>11551031</td>
</tr>
<tr>
<td>11551032</td>
</tr>
<tr>
<td>11551035</td>
</tr>
<tr>
<td>11610805</td>
</tr>
<tr>
<td>11620604</td>
</tr>
</tbody>
</table>

Where a vehicle has been previously tuned with a product other than EFILive, the conversion process may fail and render the ECM non-functional and not recoverable.

EFILive recommends users source a good known base file for CSP5.

To upgrade to CSP5 exclusively in EFILive V8 Scan and Tune software you must be running the following (or higher) software versions.

1. EFILive V8.3.8 or later.
2. FlashScan V3 / AutoCal V3 Firmware – V3.00.066.
3. FlashScan V2 / AutoCal V2 Firmware - V2.08.176.

The latest software versions are available for download from EFILive’s website.

Upgrade Operating System to CSP5

1. Open V8 Scan and Tune software and your stock tune file.
2. Navigate to [F5: Edit].
3. Expand the Internal Flash -> Operating System Patches Folder and select CSP5 v1.02 Custom Operating System.
4. Select the [Apply Upgrade] button.
5. Select [Yes] to the “This operation cannot be undone, continue?” dialog box.
6. A message indicating "Upgrade applied successfully." will now display.

7. Save the file with a new name using, **File > Save As**. Maybe something like... 'My Truck Base CSP5 Conversion.ctz'.


9. On the EFILive V8 Scan and Tune Recent Items list you will see your stock tune and your upgraded CSP5 tune. Confirm that the operating system number on the base file is different to the upgraded CSP5 converted file.

10. Reopen the tune file that was converted.

11. Navigate to **[F5: Edit]** and expand the EFILive Custom Calibrations folder.
12. EFILive automatically populates the new CSP\textsuperscript{5} tables with factory values during the upgrade. On modified engines these may not be suitable settings, so you may need to copy your own tables in to the new CSP\textsuperscript{5} section(s).

Program #1 to Program #4 have factory values inserted into the maps. Program #5 contains the values from the standard OS maps prior to the CSP\textsuperscript{5} conversion.

13. Edit the values on your individual tunes, and [Save] the changes to your tune file.
14. Flash the CSP\textsuperscript{5} tune into your ECM. Refer to pass-thru flashing, FlashScan V3/AutoCal V3 flashing or FlashScan V2 flashing for further instructions.

**Tune Switch Password**

Users may restrict tune selection by adding a password to move between tune selections to prevent unauthorized switching between tunes 1 to 5.

Before switching between tune selections, users would need to enter in the password (1 to 9999). If the password is correct, the tune will switch, if it is incorrect the tune will not switch.

It should be noted that not all switching devices may support this function, however EFILive's own FlashScan and AutoCal hardware does.

To enable the tune switch password, users need to input their chosen password in the calibration. As the calibration description states, if the password = 0 then there is no password prompt given to the user when switching tunes.

**NOTE:** Tune switch password will not restrict the activation of CSP\textsuperscript{5} Tune 6, Switch via ECM Input (labelled CSP\textsuperscript{5} Program Switched).

**CSP\textsuperscript{5} Output Driver**

The CSP\textsuperscript{5} custom OS allows you to reconfigure the "Intake Air Heater" (IAH) Output for other purposes that may be useful for racing, such as turning on a shift light, or turning on or off a relay under certain conditions.

Each controlling parameter can be enabled or disabled. For example if you only wanted to have a warning lamp come on above 3,000 RPM and above 45 MPH you would enable both those parameters and set the values accordingly.

As this function shares the same output as the factory IAH circuits you should not use this function if the vehicle still has this fitted. To ensure you don’t accidentally enable these functions with the IAH system still in place you must also let the ECM know the IAH system is not fitted. This is done by setting the calibration ‘\{F1185\} Intake Air Heater Option’ to disabled.

**Only use the CSP\textsuperscript{5} Output Driver if the IAH system had been removed.**
The output is on (Connector #2, Pin 55), when turned on the ECM applies 12V to this output, so if you are wiring in a relay or lamp the other wire needs to be connected to Negative (Ground).

Connector #2 is usually the one above the part number stickers on the ECM with a Brown and Yellow wire already connected (the IAH control).

CSP⁵ Tune 6 - Switch via ECM Input

CSP⁵ also has the provision for one tune to be switched via a spare input pin on the ECM rather than the CAN bus.

When the ECM detects a ground signal on ECM plug C2, pin 16 it will switch to this tune. This tune will override all CAN based CSP⁵ programs, even when the tune switch password is active. When the switch is not grounded the ECM will revert to the previously selected CAN based CSP⁵ tune.

This function may be useful in racing situations where you only want a certain tune to become activated when something else switches, for example a Nitrous relay. When the Nitrous relay is grounded the ECM will automatically change to this tune for you.

This input is shared with the 'Stationary Remote Power Takeoff (PTO)" in-cab switch, if the truck is fitted with the PTO option this tune will become active with the in-cab PTO activation. (E.g. 3500/4500/5500 Chassis Cab with option PTO Prep Package “LBN”). The PTO will still function as normal but these CSP tables will be used.

CSP⁵ CAN Tunes

The CSP⁵ tunes labelled "Program #1 to Program #5" are all switched via a device on the CAN bus.
NOTE: Whenever the ECM is reflashed tune switching will default to using CSP<sup>5</sup> Program #5 for pickups and Program #2 for Cab and Chassis unless the Default CSP Tune After Reflash parameter is set.

**Supported Switching Methods**

EFILive’s CSP<sup>5</sup> custom operating system can be switched using EFILive FlashScan/AutoCal V3, FlashScan/AutoCal V2, and the SoCal Diesel CSP<sup>5</sup> switch and the Starlite Diesel StarLog.

EFILive recommends that customers confirm that their chosen integration product is approved for use.

To setup an approved integration product, users should:

1. Convert their base file to a CSP<sup>5</sup> operating system, as described in this document.
2. Edit tune parameters as necessary and save the file.
3. Flash their modified file into their ECM using the V8 Scan and Tune application as described in this document. (Specific selection of 3<sup>rd</sup> party product is NOT required in tune file).
4. Setup the 3<sup>rd</sup> party device as per the manufacturer’s instructions.
V8 Scan and Tune Scan

Pass-Thru Data Logging
To log data using FlashScan or AutoCal and V8 Scan and Tune software;
1. Open the EFI Live V8 Scan and Tune.
2. Connect your FlashScan/AutoCal device to your PC and vehicle.
3. Turn the vehicle ignition to the On position.
4. Select an existing Dashboard configuration either by using the [Open Dash]
   button or using the Dashboard drop down, or configure your own customized
   dashboard after making controller and PID selections.
6. In the Engine field use the drop-down list to select the correct controller type or
   use Auto Detect option.
7. Drag the selected PID from Available PIDs window into the Selected PIDs
   window.
8. Navigate to the [F3: Data], [F4: Charts], [F5: Gauges] or [F6: Maps] tab and
   configure your dashboard to customize data display formats.
9. Users should [Save Dash] to save their custom configurations to reduce future
   configuration requirements.
10. Start the vehicle.
11. Select either Record or Monitor from the [F3: Data], [F4: Charts], [F5: Gauges]
    or [F6: Maps] screens.
12. Select Stop to stop the data logging session.
13. Save the log.
14. To replay the data log, navigate to the [F3: Data], [F4: Charts], [F5: Gauges] or
    [F6: Maps] tab and select the appropriate Playback buttons.
Important note for tuners:
If running a CSP5 tune and it does not seem to be switching as expected please check the data in the "AIRDENSC_F" PID. For CSP5 to work correctly the "AIRDENSC_F" PID must be in 'Normal Mode." If any other modes are active (e.g. Protection Mode) then the ECM will not be using normal Altitude based tables, and therefore will not using the CSP5 tables.

Protection Mode is a direct result of tuning strategy or DPF regen states.

Pass-Thru Licence and Flash a Controller
Follow these steps to license and flash the selected controller.

1. Open the EFILive Scan and Tune application.
2. Connect your FlashScan/AutoCal to your PC and your vehicle.
3. Turn the vehicle ignition to the On position, (not the Accessory position. Vehicle must not be cranked/running when flashing).
4. Select the [F3: Tune] option in the left-hand pane.
5. Click on the Open button and select the calibration file for the controller you wish to flash or license.
6. If tune file security has been applied to the tune file, review and accept the Security Warning.
7. Click on the [F7: Full Flash] options in the left-hand pane.
8. Adjust Dodge Cummins Fast CAN Mode settings where necessary;
   a. Unlimited Fast CAN delivers the fastest possible flash time and is approx. 50% faster than standard flash routines.
   b. Fast CAN is a little faster than standard, but more robust than Unlimited.
If you experience flash failures when using Unlimited Fast Can or Fast CAN, try unchecking that option and retry the flash.

9. Click on the Check License button. This will indicate if the controller is already licensed or needs to be licensed.
10. Where the controller is NOT licensed, select Activate License to license the controller.
11. Select Yes to license the controller or No to close this window without licensing the controller.

12. Select Yes to license the controller or No to close this window without licensing the controller.

13. Select the Full Flash button to commence the flash.
14. While the ECM is flashing an Elapsed time indicator, an Estimated Time Remaining indicator, and a Progress bar will display tracking the Flash progress.
15. When the flash process is complete a countdown timer will be shown. When prompted perform the following actions:
   a. Turn the vehicle ignition Off.
   b. Click on the Start button to begin the countdown timer.
   c. DO NOT turn the vehicle ignition on until the countdown timer expires. This time is critical to allow the ECM to perform internal, initialization functions after a read/flash operation.
Configure FlashScan/AutoCal for BBX

There are a range of configuration files that must be installed on FlashScan and AutoCal devices before the device can be used in standalone mode (BBX).

Follow these instructions to configure your FlashScan or AutoCal for BBX.

1. Connect your FlashScan or AutoCal to your PC.
2. Open the EFILive V8 Scan and Tune application.
3. Select the [F5: BBX] option in the left-hand pane.

EDA Data Logging

The EDA PID group aims to simplify the task of information sharing between users as every individual data parameter has been selected with tuning feedback in mind. If you choose to log additional data streams alongside the EDA stream it may slow the data logging rate down by as much as 70%.

For FlashScan V2 and AutoCal V2, BBL is only supported where CSP\(^5\) and EDA are installed.

For FlashScan V3 and AutoCal V3, BBL is supported regardless of whether CSP\(^5\) is installed.

To configure data logging:

1. Select the [F2: Scan] option in the left-hand pane.
2. Remove any unnecessary controller configurations to ensure capacity restrictions are not exceeded.
3. Add your chosen controller(s) to your list;
   a. Press the green ‘+’ icon.
   b. Right click on the Engine Controller box.
   c. Navigate to Select the correct controller.
   d. Select OK.
4. Click on the selected controller in the “BBL Enabled Controllers” window.
5. Highlight the EDA 1 folder in the “Available PIDs” window and drag into the “Selected PIDs” window. *NOTE: For FlashScan/AutoCal V2 BBL is only supported for Cummins Controllers that have CSP\(^5\) and EDA installed. Users
MUST select the entire EDA PID Group and flash a CSP5 operating system into the ECM for effective data logging.

Configure Tuning
To configure flashing for your chosen controller on your FlashScan/AutoCal;
1. Select the [F3: Tune] option in the left-hand pane.
2. Remove any unnecessary controller configurations to ensure capacity restrictions are not exceeded.
3. Add your chosen controller(s) to your list;
   a. Press the green ‘+’ icon.
   b. Right click on the Engine Controller box.
   c. Navigate to select the correct controller.
   d. Select OK.

Tune File Switching
To configure the switching of CSP5 tune positions on your FlashScan/AutoCal device;
1. Select the [F4: Switch] option in the left-hand pane.
2. Enter switchable tune names as appropriate.

Configure DTCs
To configure the display of trouble codes and descriptions onto FlashScan;
1. Select the [F5: DTC’s] option in the left-hand pane.
2. Select appropriate DTC options.

Quick Setup
To configure BBX settings, device settings, and configure tune files for BBX;
1. Select the [F6: Quick Setup] option in the left-hand pane.
2. Select appropriate BBX configuration options.
3. Edit device settings as necessary. To automatically select the most recently used controller and PID selection when FlashScan/AutoCal powers up:
   b. In the Device Settings window, navigate to [F6: Logging] and tick the “At start-up, automatically re-select the most recently used PID list.”
4. Add tune files to the Quick Setup using the green ‘+’ icon.
5. Write this configuration to FlashScan or AutoCal using the [Program Quick Setup] function. The [Program Quick Setup] programs all selected Scan, Tune, Switch, and DTC options, as well as selected device settings, BBX Quick Setup selections and tune files. Once the device is programmed, FlashScan or AutoCal is configured for BBX functions.

Each option can be programmed individually using the [Program] button on each tab, or collectively using the [Program Quick Setup] option.
FlashScan Menu Navigation

FlashScan/AutoCal V3

FlashScan/AutoCal V3 supports two menu structures; the EFILive standard menu and the user defined menu. Where a used defined menu is not installed, the EFILive standard menu will be displayed.

Data Logging

1. Configure FlashScan/AutoCal V3 for BBX features if not already setup.
2. Connect your FlashScan/AutoCal V3 device to your vehicle.
3. Turn the vehicle ignition to the On position.
4. Navigate to the Scan Tool -> F1 Select PIDs menu option.
5. Select correct controller type from BBX configured controllers.
6. Navigate to the F1 Scan Tool -> F2 Data Logging menu option.
7. Select F1: Record Data to commence the logging session.
8. The LCD will display recording status, elapsed time, frame count and the selected PIDs.
9. A range of options are available while the Log is recording:
   1. Select ✔ to pause/resume the log.
   2. Select the up and down arrows to navigate through selected PIDs.
   3. Select X, to stop data logging and save the log data.
10. Start the vehicle and drive to record actual performance. Do not attempt to operate a FlashScan/AutoCal device while your vehicle is in motion.
11. Select X on FlashScan/AutoCal V3 to stop data logging and save the log file.

License and Flash a Controller

1. Configure FlashScan/AutoCal V3 for BBX features if not already setup.
2. Copy selected tune file(s) from your PC to FlashScan/AutoCal V3 if not already copied via Quick Setup during step 1.
3. Connect your FlashScan/AutoCal V3 device to your vehicle.
4. Turn the vehicle ignition to the On position. (not the Accessory position. Vehicle must not be cranked/running when flashing).
5. Navigate to the Tune Tool menu and select F1: Tuning -> F3 Program Full menu option.
6. Navigate to the folder your tune file is located in and select ✔ to commence the flash.
7. If the controller has not been licensed by this device previously, you will be presented with an “Unlicensed Controller” message. Select ✔ to proceed with licensing the controller, or X to exit without licensing the controller.
8. Select ✔ to confirm licensing the controller and commence the flash, or X to exit without licensing the controller.
9. When the flash process is complete, select X to close the flash completed message.
10. The Reset Controller notification will be shown, and the controller reset process will begin.
1. Turn the vehicle ignition Off.
2. Click on the Start button to begin the countdown timer.
3. DO NOT turn the vehicle ignition on until the countdown timer expires. This time is critical to allow the ECM to perform internal, initialization functions after a read or flash operation.

Switch Tunes using FlashScan/AutoCal V3

1. Connect your FlashScan/AutoCal V3 device to your vehicle.
2. Turn the vehicle ignition to the On position.
3. Navigate to the Tune Tool menu and select F3 Switch Tunes -> F1 Switch CSP5 menu option.
4. Use the arrows to navigate between tunes.
5. Press ✔ to make a tune selection.
6. You do not need to reselect the tune once the engine is shut down; the ECM 'remembers' which tune you previously selected.

FlashScan V2

Data Logging

1. Configure FlashScan V2 for BBX features if not already setup.
2. Connect your FlashScan V2 device to your vehicle.
3. Turn the vehicle ignition to the On position.
4. Navigate to the F1 Scan Tool - F1 Select PIDs menu option.
5. Select correct controller type from BBX configured controllers.
6. Navigate to the F1 Scan Tool - F2 Data Logging menu option.
7. Select F1: Record Data to commence the logging session.
8. The LCD will display the elapsed time, frame count and the selected PIDs.
9. A range of options are available while the Log is recording:
   1. Select OK to pause/resume the log.
   2. Select F1..F4 or Ctrl+F1..Ctrl+F4 to add “user notes” 1 thru 8 to the log.
   3. Select Enter to toggle between Metric and US Customary units.
   4. Select the up and down arrows to navigate through selected PIDs.
5. Select Cancel, to stop data logging and save the logged data.

10. Start the vehicle and drive to record actual performance. Do not attempt to operate a FlashScan/AutoCal device while your vehicle is in motion.

11. Select Cancel on FlashScan V2 to stop data logging and save the log file.

NOTE: When data logging is activated you cannot return to the menu until logging is stopped.

License and Flash a Controller
1. Configure FlashScan V2 for BBX features if not already setup.
2. Copy selected tune file(s) from your PC to FlashScan V2 if not already copied via Quick Setup in step 1.
3. Connect your FlashScan V2 device to your vehicle.
4. Turn the vehicle ignition to the On position (not the Accessory position. Vehicle must not be cranked/running when flashing).
5. Navigate to the F2 Tune Tool -> F1 Tuning and select F3 Program Full menu option.
6. Using the arrow keys, navigate to the correct tune file and select OK.
7. If the controller has not been licensed by this device previously, you will be presented with the License this controller now? message. Select Yes to license the controller or No to exit without licensing the controller.
8. Select Yes to confirm licensing the controller and commence the flash, or No to exit without licensing the controller.
9. When the flash process is complete the Reset Controller notification will be shown. When prompted perform the following actions:
   a. Turn the vehicle ignition Off.
   b. Click on the Start button to begin the countdown timer.
   c. DO NOT turn the vehicle ignition on until the countdown timer expires. This time is critical to allow the ECM to perform internal functions after a read/flash operation.

Switch Tunes using FlashScan V2
1. Connect your FlashScan V2 device to your vehicle.
2. Turn the vehicle ignition to the On position.
3. Navigate to the F2 Tune Tool -> F3 Switchable Tunes menu option
4. Select PIDs
5. Use the arrows to navigate between tunes.
6. Press OK to make a tune selection.
7. You do not need to reselect the tune once the engine is shut down; the ECM 'remembers' which tune you previously selected.
Support

Trouble Shooting

Should users encounter problems with upgrading to CSP⁵ they should:

1. Confirm software, firmware and boot block versions match the CSP⁵ minimum requirements.
2. Confirm CSP⁵ file was upgraded to new operating system number, as sequenced above.
3. If you are concerned your device is not switching between tunes, edit your tunes to see a notable difference (ie Pedal to Desired Fuel table), reflash and then test. Also note the EDA data stream has a parameter that indicates which tune the ECM is running.
4. Check that checksums are valid.
5. CSP⁵ tune files cannot be read from the ECM.
6. Remove/isolate all after-market devices including mobile phone adapters, after-market equipment (audio systems, security, remote start etc.) and any devices wired into the OBD port that may interfere with vehicle communications.
7. DO NOT operate any vehicle feature that may communicate on the data bus. This includes opening or closing of hood, doors, windows, as well as changing settings on radio, HVAC, connecting/removing charging devices etc.

Error Codes

If an error occurs while using AutoCal, users can look up the error code description in the EFILive V8 Scan and Tune software.

The [F8: Tools] -> [F8: Error Codes] menu item provides an error code lookup function, and the “EFILive Error Codes.pdf” document accessed by selecting the Windows Start Icon and navigating to Program Files->EFILive->V8->Documents->EFILive Error Codes.pdf is also available. Both options provide error code descriptions, causes and actions.

Should the issue not be resolved after reviewing the Error code list, end users should contact their Tuner for support.

Checksums

Checksums perform a vital role in ensuring the integrity of the data in the tune file. There are two main reasons that checksums display as invalid:

1. The data in the file is corrupt and MUST NOT be flashed into a controller.
2. The data in the file has been modified with a software package that did not update the checksums – such as a hex editor.

Do not correct the checksums unless you know the tune file was modified outside of the EFILive software and that the modifications are correct and accurate.

If you correct the checksums of a file with corrupt data you are merely masking corruption. If you flash a corrupt file into a controller, you risk damaging the controller and/or causing the vehicle to operate incorrectly.
Failed Flash Recovery Methods

In the event that an ECM fails during the flashing process, recovery methods exist to restore the ECM.

Flash Base with without tune file security restrictions.

In most instances, simply retrying the flash process will return the ECM to working order.

In the instance where tuners apply security restrictions to a tune file, including locking to the controller serial number, and the flash fails, you must try to recover the ECM with a file that has no security restrictions in place (e.g. stock tune) before attempting to reflash a file with security restrictions.

ROM Boot Recovery

In some flash failure instances the ECM may stop responding and cannot be recovered to normal operation by simply retrying the flash.

Such situations may occur if the ECM was flashed with a non-compatible operating system, or where the failed flash occurred right at the end of the process but the ECM thinks it completed.

In these situations the ECM is usually only recoverable by forcing the ECM into ROM Boot Recovery mode. Specialized bench programming equipment, such as the BenchForce PowerBlock IV with ROM Boot Switch is required to perform this task.

Tips to recover the ECM using this equipment includes:

1. The ECM must be powered down. (IGN switch off but battery power connected.)
2. Hold the ROM Boot switch on.
3. Power the ECM and bench equipment.
4. Attempt to flash the ECM with your recovery file.
5. Once the flash is under way you can turn off the ROM Boot switch.

Test for Rogue Modules

For Customers with FlashScan/AutoCal V3 a range of test modes to check the network for rogue modules that may cause read or flash operations to abort are available.

Navigate to the Tune Tool -> F1: Tuning -> F4: Test OBD Network menu.

Select the Test CAN J1979 option for CAN based controllers.

Trace Files

V8 Scan and Tune *.htx files

When V8 Scan and Tune software reads or flashes a controller the details of the read/flash process may be saved in trace files for diagnostic purposes.

In addition, users can manually save trace files where options do not perform the desired outcome.

To manually generate a trace file, generate the error in V8 software, then open the EFILive Control Panel and navigate to [F8: Trace] and select [Save Trace]. Users can set the trace file and save location during this process.
Automatically generated trace files are created on your PC or laptop in the folder: Documents\EFILive\V8\Trace and are named using the following naming convention:

YYYYMMDD_HHNSS_T_CCC.htx, where:

- YYYYMMDD: is the year, month and day that the trace was recorded.
- HHNSS: is the hour, minute and second that the trace was recorded.
- T: is the mode and is one of R=Read F=Full-Flash W=Cal-Flash.
- CCC: is the controller type
- htx: is the file extension.

**FlashScan/AutoCal V3 *.xalm files**

Trace files are automatically saved where an error message is presented using the device in BBX mode. Users can manually save trace files where options do not perform the desired outcome, including for pass-thru functions.

To manually generate a trace file on FlashScan/AutoCal V3 navigate to Scan Tool -> F3: Scan Options -> F1: Save Trace.

FlashScan/AutoCal V3 maintains an internal buffer of the most recent messages sent to and received from the vehicle. That buffer is stored in RAM memory and is wiped clean each time the device is powered off or rebooted. Therefore you MUST save the trace file before powering off or rebooting the device.

Trace files are located in the EFILive -> Trace folder on FlashScan/AutoCal V3. Trace files are named using the following naming convention:

yyyymmdd_hhnss_<desc>.xalm, where:

- yyyyymmdd: is the year, month and day that the trace was recorded.
- hhnnss: is the hour, minute and second that the trace was recorded.
- <desc>: is the description where:
  - “User” means user generated trace files
  - “xxx._x_$$$xxx” identifies the 3 character controller ID, the communication process upload/download, and the 4 digit error code.
- xalm: is the file extension.

**FlashScan V2 Trace Files**

Trace files are automatically saved where an error message is presented using the device in BBX mode. Users can manually save trace files where options do not perform the desired outcome.

To manually generate a trace file on FlashScan V2 navigate to F1 Scan Tool -> F3 Scan Options -> F1 Save Trace File.

FlashScan V2 maintains an internal buffer of the most recent messages sent to and received from the vehicle. That buffer is stored in RAM memory and is wiped clean each time the device is powered off or rebooted. Therefore you MUST save the trace file before powering off or rebooting the device.

Trace files are located in the Scan folder on FlashScan V2. It will be named USR_xxxx.efx, where xxxx is the unique file counter number.

**Knowledgebase**

The EFILive Knowledgebase provides a detailed resource on how to configure and use your EFILive software and hardware.
EFI Live Authorized Dealer

If after reviewing this guide further assistance is required please contact the EFI Live Authorised Dealer from whom you purchased your product. They are your first point of contact for EFI Live support related inquiries.

How to Tune?

EFI Live is tuning software and hardware - it is not a tune. Together the software and hardware give users the tools to write tunes. EFI Live does not provide tune files, tuning advice or support, but do provide software support and hardware support.

If your question is in relation to the actual tuning of your vehicle (e.g. how to gain performance, economy etc.) then please ask these questions on the EFI Live Forum (http://forum.efilive.com/).

EFI Live Service Desk

Should you require additional assistance after using this support guide, please start a ticket on the EFI Live Service Desk. Please include the following information:

1. Dealer Name.
2. Device type.
4. Your computer operating system.
5. Software and firmware versions.
6. Trace files.
7. Detailed information about your issue.